c) Wolters Kluwer

Release Notes

Release 2017.3.3
February 2019

CCH® ProSystem fx® Workpaper Manager

Welcome to CCH® ProSystem fx® Workpaper Manager v2017.3.3

This bulletin provides important information about the v2017.3.3 release of CCH ProSystem fx Workpaper Manager. Please review this
bulletin carefully. If you have any questions, additional information is available on CCH Support Online.

Note: There are two guides that provide important information relating to the installation and deployment of Workpaper Manager. These
are the Installation Guide and the Deployment Planning Guide found in the Documents folder with the Install Media.

How to Deploy - For IT Administrators and Third-Party IT Providers Release - CCH ProSystem fx Workpaper
Manager

1. Close CCH ProSystem fx Workpaper Manager before running the installation files.
2. Close all Microsoft® Office applications, such as Word, Excel® and Outlook®.
3. Download the installation file using CCH Software Delivery Manager.
4. Install a SQL instance.
Note: SQL 2016 installations should be run locally rather than from the network.
5. Install CCH ProSystem fx Workpaper Manager.

Note: You can confirm the Workpaper Management, Trial Balance, and TGUW version numbers by reviewing the following
registry key: <computer>\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\ProFxENGAGEMENT30\Common

For further information see "How do | install CCH ProSystem fx Workpaper Manager?" on CCH Support Online.

New in this 2017.3.3 Release - CCH ProSystem fx Workpaper Manager

2018 Tax Grouping List Template Update
The following 2018 tax grouping list templates (.AZG files) were updated as detailed in the Knowledge Base article here.

e 2018 C-Corp - ProSystem fx Tax

e 2018 S-Corp - ProSystem fx Tax

. 2018 Exempt Org - ProSystem fx Tax
e 2018 S-Corp - Lacerte

e 2018 S-Corp - UltraTax


https://support.cch.com/productsupport/productSupport.aspx?id=10
https://support.cch.com/kb/solution.aspx/sw33791
https://support.cch.com/kb/solution/000097390/97390

Important: The updated templates are applicable only when creating 2018 tax grouping lists by importing from the Account
Groupings - Grouping List Options dialog. The update has no effect on 2018 tax grouping lists created by running the Tax Grouping
Update Wizard.

Provided in a Prior 2017 Release - CCH ProSystem fx Workpaper Manager

2018 Tax Grouping Update
The 2018 Tax Grouping Update includes the changes as detailed in https://support.cch.com/kb/solution/000094697

CCH® ProSystem fx® Tax and CCH Axcess™ Tax

e The Tax Grouping Update Wizard will update tax grouping lists to 2018 tax codes.

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership, Exempt and Individual tax entity types.
Lacerte®

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership and Exempt tax entity types.
GoSystem® Tax

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership and Exempt tax entity types.
UltraTax CS®

e New 2018 tax grouping lists available for Corporation, S Corporation, Partnership, Exempt and Individual tax entity types.

Updated Delete Binders Utility
Filters applied in the Delete Binders Utility are updated such that all binders selected for deletion in the list of filtered binders delete as
expected. You can now hold down either the SHIFT or CTRL key to select multiple binders in the list.

Viewing the Contents of and Adding Workpapers to a Central File Room (CFR) Binder

A central file room binder to which you are assigned can now be opened in the CFR pane of the File Room window to view the tabs,
workpapers, and workpaper notes in the binder. In addition, workpapers from a file can be added directly to the binder without
synchronizing it to your local file room.

Reviewing and working with a central file room binder has the following limitations as compared to reviewing and working with a local file
room binder:

e The tabs, workpapers and notes cannot be opened or edited.

e Only the details of workpaper notes can be reviewed. Details for tab notes are not available for review.
e When adding workpapers to the binder, the original source workpaper cannot automatically be deleted.
e Workpapers already in the binder cannot be overwritten when adding a workpaper.

Copying Journal Entry Lines from Excel® to the Journal Entry Detail Dialog

You can quickly setup multiple detail lines for a journal entry by copying rows of data from an Excel® spreadsheet that includes Account #,
Description, and Debit and Credit columns. After copying the rows from Excel®, they can be pasted into the detail lines grid of the Journal
Entry Detail dialog. The Description column is required in the Excel® spreadsheet, but it will be ignored and thus, can be blank in the
spreadsheet if desired.

Improvements to TB Reports Created in Workpaper Manager Release 7.5 or Later
Trial balance and journal entry reports created in Workpaper Manager release v7.5 or later now refresh more quickly. In addition, the
following edits to reports are retained when the report refreshes:


https://support.cch.com/kb/solution/000094697

e Microsoft® Excel® Comments (and other markups within editable areas of the report).

e  Formats (i.e. Font and highlighting to even the protected areas of the report).

e Zoom setting.

e  Freeze panes setting.

e  Column width adjustments (including 50 editable columns to the right of the report).

e Row height adjustments (with some exceptions).

e Auto Calculate setting to avoid blank headers/blank variance columns.

e  State of expand/collapse for journal entry detail rows.

¢ Hiding journal entry detail that nets to zero when the setting to hide zero balance accounts is selected.

e In Excel®, File > Print > Page Setup > Sheets > Rows to repeat at top option setting is retained so that header information prints on
all pages of the report.

All Trial Balances are Now in Excel®.xlsx File Format

All new trial balances (fund, standard, consolidated, and write up) are now in the Excel®.xlsx file format to allow for up to 100,000 accounts
to be set up in any trial balance. Trial balances in new binders created from the New Binder Wizard or by rolling forward or copying a binder
will be in the Excel®.xIsx file format. However, trial balances in existing binders will not be converted to the .xIsx format.

Using Passwords that Meet Firm Rules
When the option to define password rules is selected in Firm Options, staff members will be prompted to change their password in the
following circumstances:

e Anadministrator has assigned a temporary password in Staff Properties of the Administrator application.
e The staff member’s current password does not meet one or more of the password rules.
e The staff member’s password has expired.

See the Password Rules in Firm Options below for more information about turning on a Firm Option to require staff to have passwords that
meet certain rules.

Provided in a Prior 2017 Release - CCH ProSystem fx Workpaper Manager Administrator

Password Rules in Firm Options
Administrators can now optionally define rules for staff login passwords. A check box option in Tools > Firm Options can be selected to
require staff member login passwords to meet certain rules. A new dialog is provided to define the rules.

Rules: In addition to being able to select from the rules listed below, passwords are case sensitive.
e At least ### characters (1 to 128)
e Atleast 1 upper case character (A to Z)
e Atleast 1 lower case character (a to z)
e Atleast1digit(0to9)

e  Atleast 1 special character (space is special)



e Must not contain staff member login name
¢ No historical reuse for last ### passwords (1 to 100)
e Require staff to change their password every ### days (1 to 365)

If the password rules option is turned on in Firm Options and an administrator assigns a password to a staff member in Staff Properties, the
staff member will be prompted when he/she logs into the Workpaper Manager application while connected to an office server to change
the temporary password to one that meets the rules. The staff member will also be prompted to change their current password if at any
time it has either expired or does not meet one or more of the selected rules.

Please refer to the Workpaper Manager Knowledge Base article, Staff Password Rules Best Practices, prior to turning on and setting up firm
password rules.

Updated Admin Views Utility

The Admin Views Utility has been updated to improve the performance for loading data in the grid for the selected view. For views where a
large number of records will be retrieved from the database, such as some of the binder views, a Filter Conditions dialog displays to enter
one or more conditions to reduce the data to retrieve from the database.

For some of the views, you can drill down by clicking the plus (+) to expand a row in the grid to view to more detailed information. For
example, with the Binder Properties view, you can drill down to review Tab, Workpaper, Team and Staff binder-specific details.

A new Staff Password Information view is provided for determining when a staff member’s password will expire (assuming your firm has
selected the rule to require staff to change their password at regular intervals).

Issues Resolved in a Prior 2017 Release

TB Report refresh stalls at 62%
When the latest Microsoft® Office updates for either 2013 or 2016 versions of Office are installed, TB reports will no longer stall at 62%
when refreshing.

Reviewer Sign Off Message
A message will no longer display when the current editor opens a Word or Excel® workpaper that is signed off as reviewed. A more user-
friendly warning mechanism will be provided with the summer 2018 release.

Missing Functions in Add-in Ribbon and Right-Click Menu in Excel®

The issues introduced by Microsoft® with Office 365™ v1707(Build 8326.2107), which includes the desktop version of Microsoft® Office
2016, that was causing the CCH® ProSystem fx® Workpaper Manager menu commands on the ribbon and right-click menu to be missing in
Microsoft® Excel® workpapers will no longer occur. See Knowledge Base article, Microsoft® Office 365™ September update results in
multiple addin issues in CCH® ProSystem fx® Engagement or Workpaper Manager for further information.

Resolved Knowledge Base Article 68882
The error "Unable to open TBState file for read" when the PfxEngagement.exe process is launched using the short file name, will no longer
occur during launch of Microsoft® Excel®.

Issues identified in a previous release of Workpaper Manager have been resolved to enhance your workflow, including:
e  The option to send an Workpaper Manager workpaper to a mail recipient now works with Microsoft® Office 64-bit editions.
e The Consolidated balance correctly includes EJE's after reconsolidating with one or more prior periods.
e During Paste TB Import, if you select to round the balance, you will be notified if you have not selected a rounding account.

e Detail trial balance reports are able to be created even when any TB column abbreviation is over 16 characters.


https://support.cch.com/kb/solution.aspx/000065840
https://support.cch.com/kb/solution.aspx/Microsoft-Office-365-September-update-results-in-multiple-addin-issues-in-CCH-ProSystem-fx-Engagement-or-Workpaper-Manager
https://support.cch.com/kb/solution.aspx/Microsoft-Office-365-September-update-results-in-multiple-addin-issues-in-CCH-ProSystem-fx-Engagement-or-Workpaper-Manager

e The binder retention date is correctly calculated, and binders can be finalized without error when the Binder Properties Date of
Report and/or Report Release Date is a leap year day (02/29/####).

e Astronger password is being used for the SQL Admin (sa) account which will prevent SQL installation failures where complex
passwords are required.

Technologies No Longer Supported

As communicated last year, the following technologies are no longer supported:
¢ Microsoft® Windows Server® 2008 and 2008 R2
e Microsoft® Office 2010

e Adobe® Reader X and Adobe® Acrobat® X

Technologies Supported

The following new technologies are now supported:
e Microsoft® Windows Server® 2016
e Microsoft® SQL Server® 2016 (available in 64-bit only)
e QuickBooks® 2017
e  Citrix® XenApp® v7.12
e Adobe® Reader 2017 and Adobe® Acrobat® 2017

At Wolters Kluwer, we want to ensure that we are staying current with the latest technologies. Therefore, going forward, we will support
only the current and one prior version of both third-party technologies and our CCH applications. The latest system requirements can be
found on the Workpaper Manager Support site CCH Support Online.

Important Notes

Workpaper Manager in 2017
Beginning with this release, we will no longer support Workpaper Manager versions prior to v7.2.

In order to ensure the highest quality support and product experience, CCH will only offer support for the current version and one previous
year's version of the software. For this purpose, “support” is defined in two parts: Technical Compatibility and Customer Support.

SQL Admin Login (sa) Now Supports Complex Password Policies

Previously the SQL admin login failed to use a complex password. This resulted in SQL installation failures when firm level security policies
were not properly met. The new password has better support for more complex requirements. If you have applications which require the
SA account login, it will be critical that you plan to update to the new password as part of the upgrade process. Failure to do this will result
in login problems for those applications. Please refer to the Workpaper Manager Knowledge Base article 66404 for further information
about the SQL Admin login changes.

Tax Grouping Update Wizard

You can no longer run the Tax Grouping Update Utility from a machine with only the Administrator module installed. You must run the Tax
Grouping Update Wizard from a machine that has either the Workpaper Management module installed, Administrator and Workpaper
Management modules installed, or Terminal Services Client installed.


https://support.cch.com/productsupport/productSupport.aspx?id=5
https://support.cch.com/kb/solution.aspx/000066404

CCH® ProSystem fx® Practice Advantage
We removed the Practice Advantage integration with this release.

Installation Information
Please refer to the Installation Guide and the Deployment Planning Guide for important information relating to the installation and
deployment of Workpaper Manager. These guides may be found in the Documents folder with the Install Media.

.NET 4.6.1 Full Required for All Installation Options
The installation requires .NET 4.6.1 Full for WM, TSClient, TSDatabase, Admin, and AdminWS installations.

Service Packs
It is strongly recommended that the latest service packs for operating systems and other software are installed in order for Workpaper
Manager to run optimally. Please refer to the Installation Guide for more details on the recommended and required versions.

Upgrade Operating System or Microsoft® Office
If applicable, complete operating system or Microsoft® Office upgrades prior to installing the latest version of Workpaper Manager.

Refer to the Installation Guide for detailed information regarding the installation and configuration of Workpaper Manager.

Upgrade Workpaper Manager

Upgrades to Workpaper Manager v2017.2.5 are supported from Workpaper Manager v7.2 and v7.5. It is required that all Workpaper
Manager office servers and workstations be upgraded. If you are currently using a version prior to 7.2 and require assistance with
upgrading, please contact Technical Support.

When upgrading the Workpaper Manager Administrator module from v7.2 or higher, you will be required to reset your name and password
after the installation of v2017.2.5, if you have changed the logon account for the PFXSYNPFT Service to allow workpapers to reside on a
remote server. Failure to do so will result in failed synchronizations.

During a new installation of Workpaper Manager Administrator module, the creation of bin databases for storing binder information will
default to the installation directory (x:\Pfx Engagement\Admin\Data). If you prefer the bin to be created in a location other than the Admin
installation directory, you must change the bin directory path on the Choose Bin Database Path dialog during the installation. Please refer
to the Installation Guide for additional information.

For specific user rights requirements, please refer to Appendix E in the User Guide.

Ports
Workpaper Manager transfers data over the following ports:

e SQL Server (PROFXENGAGEMENT) - TCP port 2029; UDP port 1434
e Pfx.Engagement.SocketService - TCP port 4531

e PFXSYNPFTService - TCP port 6735

e PFXEngDesktopService - TCP port 6736

e  PfxConfigUtility - UDP port 6737

e  P2EWinService - TCP ports 943 and 4530

e  SharedFileRoom - TCP port 445

These ports are configured on the server and workstations during installation. However, if you are connecting over a VPN, through a
firewall, or another device such as a router, you will need to ensure that these ports are opened for the program to work correctly.



Mass Deployment

Workpaper Manager allows for mass deployment/installation by way of pushing the install to computers. Installs using an MSI file vary
depending on what deployment tool is used. For instructions on how to complete the installation with an MSI package using Microsoft®
Active Directory®, please refer to the Installation Guide. If you are using a deployment tool other than Microsoft® Active Directory®, please
consult your deployment application documentation for further instructions on how to push the install with an MSI package.

Minimum Requirements

The minimum system memory for Workpaper Manager Administrator or Workpaper Management modules on a 32-bit computer is 2 GB. In
addition, Workpaper Manager requires MDAC 2.8 SP1 or higher on each workstation. Please see the Installation Guide for additional
information.

Logging In After Update
After the upgrade from a previous version, there is a VSTO clean-up process that will add time to the initial log in to Workpaper Manager. It
may be helpful to notify end users of the additional initial login time.

SQL Express/SQL Upgrade

SQL Server® Express is a free edition of SQL Server® that may be used in conjunction with Workpaper Manager. If firms choose to purchase
Microsoft® SQL Server® 2012, Microsoft® SQL Server® 2014 or Microsoft® SQL Server® 2016, there may be additional licensing costs
associated. Please refer to Microsoft® SQL Server® versions for detailed licensing options.

Important: Workpaper Manager v2017.2.5 supports Microsoft® SQL Server® Express, Standard and Enterprise editions in versions 2012,
2014 and 2016, as its database engine.

Operating Systems Not Supported
Workpaper Manager should not be installed on the following:

e Microsoft® Small Business Server (for more information, see http://support.cch.com/kb/solution.aspx/sw34431)

¢ A Domain Controller Server (for more information, see http://support.cch.com/kb/solution.aspx/sw3787)

e An Exchange Server

e Linux, as it is supported for workpaper storage only.

Conversion of Binders, Templates, Packages and Trial Balance Databases

Binders
When upgrading, the Workpaper Manager binder databases will be converted during the installation process.

Important: Prior to installation, ensure there is a successful backup of the Workpaper Manager databases, workpapers, and templates. For
additional information, please refer to Appendix F: Database Backup and Restore in the User Guide.

Templates and Binder Packages

All binder templates must be converted from the Workpaper Management module after installing Workpaper Manager v2017.2.5. Binder
templates created in v4.0 or later may be converted directly to v2017.2.5. Binder template conversion must be run on a machine with a
local installation of Workpaper Manager Workpaper Management. Users in a Citrix® or Terminal Services environment should convert the
binder templates in a non-Citrix® or non-Terminal Services environment. The binder templates can then be copied to the Citrix® or Terminal
Server.

Trial balance templates created in Workpaper Manager v4.0 or higher can be converted via a process provided on the File menu of the
Workpaper Manager File Room.

Binder packages created in Workpaper Manager v4.0 or higher will automatically be converted to v2017.2.5 when received into a local file
room. Binders archived in v4.0 or higher may be unarchived with v2017.2.5. Binder backups created in Workpaper Manager v4.0 or higher
can be restored into v2017.2.5.


http://www.microsoft.com/sqlserver/en/us/editions/previous-versions.aspx
http://support.cch.com/kb/solution.aspx/sw34431
http://support.cch.com/kb/solution.aspx/sw3787

Trial Balances
Trial balances created in Workpaper Manager v5.7 or earlier will be automatically converted when synchronizing the binder or receiving the
binder package.

Database Backup & Restore

Regular nightly backups of Workpaper Manager databases, workpapers, and templates will enable you to restore them in the event of a
hardware failure or other disaster. In addition, you can choose to incorporate differential backups as part of your backup strategy. If you
require assistance in setting up a scheduled nightly backup or ensuring your current backup is capturing all necessary files, please visit
http://support.cch.com/kb/solution.aspx/sw33890 or contact Technical Support.

During the installation of the Workpaper Manager Administrator module v2017.2.5, the Database Backup & Restore Utility will
automatically be installed to the x:\Pfx Engagement\Admin\Utilities\Backup Restore directory.

Important: If you are currently using third-party backup software to back up the Workpaper Manager databases, you will not be able to
restore a single binder to the central file room. The CCH® ProSystem fx® Workpaper Manager Database Backup & Restore Utility allows the
restoration of a single binder or an entire central file room.

For additional information about the Database Backup & Restore Utility or instructions on setting up a scheduled task for the nightly
backup, please refer to Appendix F: Database Backup & Restore in the User Guide.

Other Information

Microsoft® Windows® 7 and Windows® 8.1

When running the CCH® ProSystem fx® Workpaper Manager Configuration Utility in a Windows® 7 or Windows® 8.1 environment with User
Account Control (UAC) enabled, the Interactive Services Detection service must be running. The recommended best practice is to configure
the Interactive Services Detection service to start automatically.

Virtualization included in Microsoft® Windows® 7 or Windows® 8.1 limits users' rights to certain directories with User Account Control
(UAC) enabled. Due to these limitations, it is recommended that Workpaper Manager not be installed to the C:\Windows,
C:\Windows\System 32, or C:\Program Files directories. For additional information, refer to

Microsoft's Windows Vista Application Development Requirements for User Account Control Compatibility document. Please contact
Technical Support for installations of Workpaper Manager v7.2 or higher that currently exist in these locations.

Microsoft® Office 2013 Ribbon

The Workpaper Manager menu items will appear on both the Workpaper Manager Ribbon and on the Add-Ins tab. It is possible to disable
the Workpaper Manager Ribbon functions by going to the Excel®/Word Options and choosing Add-Ins. Select Manage COM Add-ins and
uncheck Pfx.Ribbon.ExcelAddIn (for Excel®) or Pfx.Ribbon.WordAddin (for Word) from the list of Add-Ins available.

Microsoft® Office 365™

Microsoft® offers multiple packaging options (called “plans”) for Office 365™, which are either available with online only versions of the
Office applications or desktop versions. (For example, Office 365™ Midsize Business or Office 365™ Enterprise E3.) To use Office 365™ with
Workpaper Manager, you must subscribe to a version of Office 365™ that includes a desktop version and have the desktop version of Office
installed on the PCs that will be running Workpaper Manager. In this scenario, the experience is essentially the same as the running
Microsoft® Office 2013.

Note: CCH does not currently have plans to support online only versions of Office. This is largely due to the fact that Microsoft® does not
support customized ribbons/add-ons in the online versions.

Go here for a comparison of the different Microsoft® Office 365™ plans, and which ones include desktop versions of the applications.



http://support.cch.com/kb/solution.aspx/sw33890
http://msdn.microsoft.com/en-us/library/bb530410.aspx
http://office.microsoft.com/en-us/business/compare-all-office-365-for-business-plans-FX104051403.aspx

Office Servers/Administrator Module
Changing the computer name after Workpaper Manager is installed is not supported. Changing the computer name may cause login
failures, synchronization failures, and database errors.

System time clocks must be synchronized across all office servers to ensure proper data flow between servers. Failure to properly ensure
that all time clocks are synchronized before performing Administrator module functions may result in data loss.

Static IP addresses are recommended for all office servers.
All office servers should be synchronized before adding a new office server or updating to a new version of Workpaper Manager.
All Administrator users must have access and rights to the Admin Share directory on all office servers.

Export to Tax
Dynalink from Workpaper Manager to CCH® Global fx Tax through a Citrix® session is not supported.

Dynalink to both Global fx Tax and the desktop application for a single client is not supported.

When using the Dynalink option to export trial balance data to CCH® ProSystem fx® Tax or CCH Axcess™ Tax, the Employer ID # (EIN) used
for the Dynalink configuration on the Tax Software Interface dialog in Workpaper Manager must be unique. If you have multiple clients that
will be using the same EIN, please add additional characters to the end of the EIN to make each one unique (e.g., 99-999999-1).

Synchronization
Synchronization utilizes two services for data transfer. The services are PEXSYNPFTService.exe and PfxEngDesktopService.exe. For further
information regarding these services and how they function, please refer to Appendix E in the User Guide.

General
Workpaper Manager toolbar customizations may be made using a 1024x768 or greater screen resolution. Lower screen resolutions may
result in the inability to view additional toolbar buttons added to the Workpaper Manager toolbar.

Large fonts are not supported by Workpaper Manager.

CCH Software News Delivers Valuable Product Information via Email

CCH Software News expedites important CCH ProSystem fx product information to your firm via email. Technical bulletins, tax, technical
discussions and product update notifications are forwarded directly to your individual and/or firm’s email address, ensuring that you are
kept abreast of pertinent issues which affect your CCH ProSystem fx products.

If you provided an email address with your order, you are already registered for CCH Software News and will receive information on the
products your firm is currently licensed for in the near future. We encourage you to visit our website at CCH Support Online and click on
CCH Software News Profile Setup to establish or modify your firm’s CCH Software News profile to ensure you are receiving information on
all the CCH ProSystem fx products you desire.



http://support.cch.com/productsupport/productSupport.aspx?path=%2fTopics%2fproduct_support%2fpfx_office%2fpfx_engagement
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